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Copyright

Dieses Dokument unterliegt dem Copyright © 2010–2024. Die Beitragenden sind unten 
aufgeführt. Sie dürfen dieses Dokument unter den Bedingungen der GNU General Public 
License (http://www.gnu.org/licenses/gpl.html), Version 3 oder höher oder der Creative 
Commons Attribution License (https://creativecommons.org/licenses/by/4.0/) Version 4.0 
oder höher, verändern und/oder weitergeben.
Warennamen werden ohne Gewährleistung der freien Verwendbarkeit benutzt.
Fast alle Hardware- und Softwarebezeichnungen sowie weitere Stichworte und sonstige 
Angaben, die in diesem Buch verwendet werden, sind als eingetragene Marken geschützt.
Da es nicht möglich ist, in allen Fällen zeitnah zu ermitteln, ob ein Markenschutz besteht, 
wird das Symbol (R) in diesem Buch nicht verwendet.

Mitwirkende/Autoren
Harald Berger
Michael Otto
Regina Henschel
Gerhard Weydt

Englisches Originaldokument
Dieses Kapitel wurde ursprünglich aus dem Englischen übersetzt und basiert auf dem
Guide Draw Chapter 2 – Drawing Basic Shapes. Autoren dieses Kapitels sind:
Peter Schofield
Claire Wood
Elzett Kotze
Jean Hollis Weber
John A Smith
John Cleland
Martin Fox
Regina Henschel

Rückmeldung
Kommentare oder Vorschläge zu diesem Dokument können Sie in deutscher Sprache an die 
Adresse discuss@de.libreoffice.org senden.

Vorsicht

Alles, was an eine Mailingliste geschickt wird, inklusive der E-Mail-Adresse und 
anderer persönlicher Daten, die die E-Mail enthält, wird öffentlich archiviert 
und kann nicht gelöscht werden. Also, schreiben Sie bitte mit Bedacht!
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Datum der Veröffentlichung und Softwareversion
Veröffentlicht am 15.11.2024. Basierend auf der LibreOffice Version 24.8 Community.
Andere Versionen von LibreOffice können sich im Aussehen und der Funktion unterscheiden.

Verwendung von LibreOffice unter macOS
Einige Tastenbelegungen und Menüeinträge unterscheiden sich zwischen der Macintosh-
Version und denen für Windows- und Linux-Rechner. Die unten stehende Tabelle gibt Ihnen 
einige grundlegende Hinweise dazu. Eine ausführlichere Aufstellung dazu finden Sie in der 
Hilfe der jeweiligen Komponente.

In Windows/Linux entspricht unter macOS Effekt
Menü
Extras > Optionen LibreOffice > Einstellungen Zugriff auf die Programmoptionen

Rechtsklick Ctrl+Klick und/oder Rechts-
klick je nach Einstellungen Öffnen eines Kontextmenüs

Strg (Steuerung) ⌘ (Command) Tastenkürzel in Verbindung mit 
anderen Tasten

Alt ⌥ und/oder Alt oder Option Tastenkürzel in Verbindung mit 
anderen Tasten

F11 ⌘+T Öffnen der Formatvorlagen in der 
Seitenleiste

Synonyme
In diesem Dokument verwendete Synonyme:

für
Abschnitt
Anfasser (Punkte am Ende einer Symbolleiste)
Deck
Dialogfeld, Dialogbox
Dropdown-
Menüleiste, Hauptmenü,
Objektpunkte (quadratisch, rund, oval)
Popup-Menü
Register, Reiter
Tabulator
Tooltip

in diesem Dokument verwendet
Bereich
Griff(e)
Bereich
Dialog
Auswahl-
Menü
Ziehpunkte
Menü
Tab
Tabulator
Direkt Hilfe

Viele Begriffe im Bezug zu LibreOffice und den darin verwendeten Techniken finden Sie im 
Glossar. Das Handbuch Glossar wurde für alle Komponenten von LibreOffice erstellt und 
kann im Bereich „Erste Schritte  ganz unten heruntergeladen werden.‟

Sie sehen vielleicht etwas anderes
LibreOffice läuft auf Windows, Linux, Mac OS X, FreeBSD und anderen Unix-Varianten, von 
denen jedes Betriebssystem unterschiedliche Versionen hat und kann von den Nutzern 
bezüglich Schriftarten, Farben und Themen angepasst werden.
Die Bilder in diesem Handbuch wurden mit hellem Thema in Windows 10 erstellt. Das 
LibreOffice Thema entspricht der Werkseinstellungen.
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Querverweise hier im Dokument
Anklickbare Querverweise hier im Quell-Dokument (.odt) sehen Sie grau hervorgehoben, 
wenn Sie den Umschalter im Menü Ansicht > Feldhinterlegungen (Strg+F8) einschalten.

Links zu externen Quellen
Anklickbare Links zu externen Quellen werden wie folgt dargestellt:
LibreOffice – Startseite
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Einführung
Der Hauptzweck von Draw ist es, Zeichnungen zu erstellen, die zweidimensionale geome-
trische Formen (also beispielsweise Linien, Rechtecke, Ellipsen) enthalten, meist mit 
ergänzendem Text. Draw kann auch kompliziertere Dinge wie dreidimensionale Bilder oder 
Diagramme und abspielbare Medien in einem Dokument speichern.
Um all diese unterschiedlichen Formen unter einen gemeinsamen Begriff zu fassen, spricht 
man von Objekten; dies ist ein üblicher Begriff in der Software für Vektorgrafiken.
Dieses Kapitel behandelt die grafischen Grundobjekte von Draw, als da sind Rechtecke, 
Dreiecke Kreise und ähnliche, zum Teil daraus abgeleitete Formen, wie sie von Draw bereits 
zur Verfügung gestellt werden. Wie Sie mit anderen von Draw unterstützten Objekten 
umgehen können, behandeln die folgenden Kapitel dieses Handbuchs.
Auf Seite 33 finden Sie den Draw Startbildschirm mit Legende.

Die Symbolleiste Zeichnung
Der einfachste Weg zum Einfügen von Formen ist meist die Symbolleiste Zeichnung. 
Standardmäßig sieht sie wie in Abbildung 1 aus.
Die Symbolleiste Zeichnung können Sie über folgende Wege aufrufen:

• im Menü Ansicht > Symbolleisten > Zeichnung
• in der Symbolleiste Standard mit dem Symbol Zeichnungsfunktionen anzeigen .

Sie können die Symbolleiste Zeichnung wie gewohnt abreißen und frei auf dem Bildschirm 
platzieren. Näheres finden Sie in im Kapitel 1 Einführung in LibreOffice des Erste Schritte 
Handbuchs.

Abbildung 1: Symbolleiste Zeichnung mit Legende

1. Auswahl
2. Linienfarbe
3. Füllfarbe
4. Linie einfügen
5. Rechteck
6. Ellipse
7. Linien und Linienspitzen
8. Kurven und Polygone

9. Verbinder
10. Grundformen
11. Symbolformen
12. Blockpfeile
13. Flussdiagramme
14. Legenden
15. Sterne und Banner
16. 3D-Objekte

Kurzerläuterung zu Symbolleiste Zeichnung
Die Symbolleiste enthält von links nach rechts die Zeichnungswerkzeuge, siehe Abbildung 1. 
Die Bedeutung eines Symbols sehen Sie auch in der Direkthilfe, die Sie durch Zeigen mit der 
Maus auf das Symbol anzeigen können.
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1. Auswahl - wenn dieses Werkzeug aktiv ist, können Sie die Objekte durch Anklicken 
oder Einrahmen mit der Maus auswählen. Sie benötigen diese Schaltfläche beispiels-
weise, wenn sie vorher eines der Symbole für die Formen dauerhaft eingeschaltet 
hatten (siehe Mehrfaches Einfügen des gleichen Objekttyps auf Seite 11).

2. Linienfarbe – hiermit können Sie einfache Linien, Linien mit Anfangs- und Endlinien-
spitzen und die Ränder von Objekten einfärben.

3. Füllfarbe – füllt alle Objektflächen.
4. Linie einfügen – fügt eine gerade Linien ein.
5. Rechteck – zeichnet ein beliebiges Rechteck, das Sie aufziehen können.
6. Ellipse - zeichnet eine beliebige Ellipse, die Sie aufziehen können.

Hinweis

Die Werkzeuge Rechteck und Ellipse finden Sie auch bei den Grundformen, 
sowie Linie einfügen bei den Linien und Linienspitzen, zu denen sie thematisch 
gehören. Weil sie aber sehr häufig benötigt werden, sind sie zum schnelleren 
Zugriff hier direkt aufrufbar.

7. Linien und Linienspitzen – hier können Sie direkt Linien mit Pfeilspitzen auswählen, 
sowie Maßlinie und Linie (45°.)

8. Kurven und Polygone - zeichnet eine beliebige Kurve oder Polygon, das Sie aufziehen 
können.

9. Verbinder – werden benötigt, wenn Sie zwei oder mehrere Objekte verbinden 
möchten, siehe Verbinder auf Seite 20.

Die Werkzeuge für die Formen werden in den folgenden Abschnitten detaillierter behandelt. 
Dabei ist zu beachten, dass bei den Symbolen, die durch einen Pfeil  zu erkennen geben, 
dass durch ihre Betätigung eine Palette mit weiteren Symbolen geöffnet wird und statt des 
normalerweise gezeigten Symbols, das zuletzt gewählte Symbol aus der Palette in der 
Symbolleiste angezeigt wird. Das Bild der Symbolleiste kann also bei Ihnen durchaus von 
dem in Abbildung 1 gezeigten abweichen.

Die Symbolleiste Zeichnung erweitern
Die Symbolleiste zeigt standardmäßig die am häufigsten verwendeten Befehle an. Durch 
einen Rechtsklick mit der Maus auf die Symbolleiste oder einen Klick auf die Schaltfläche  
am rechten Ende der Kopfleiste einer abgerissenen Symbolleiste können Sie ein Menü 
öffnen, das alle für die Symbolleiste verfügbaren Befehle enthält, auch die, die nicht in der 
Symbolleiste angezeigt werden, siehe Abbildung 2 (auf Seite 9, die Abbildung ist aus Platz-
gründen in zwei nebeneinander angeordnete Teilstücke aufgeteilt):
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Abbildung 2: Das Menü der Symbolleiste Zeichnung

• Im oberen Abschnitt des Menüs sehen Sie eine Liste aller Befehle die nicht auf der 
Symbolleiste enthalten sind. Diejenigen, die für das ausgewählte Objekt nicht 
ausführbar sind, sind ausgegraut.

• Der letzte Abschnitt ab dem Befehl Sichtbare Schaltflächen, der im Folgenden noch 
erläutert wird, enthält Befehle zur Handhabung der Symbolleiste:
◦ Symbolleiste anpassen… - führt zum gleichen Dialog wie Extras > Anpassen > 

Symbolleisten, der im Kapitel 14 - LibreOffice anpassen des Handbuchs Erste 
Schritte beschrieben ist. Dort können Sie auch Befehle in die Symbolleiste einfü-
gen, die von LibreOffice nicht dafür vorgesehen sind, beispielsweise auch eigene 
Makros.

◦ Symbolleiste andocken und Alle Symbolleisten andocken - und Abreißen von 
Symbolleisten ist allgemein in Kapitel 1 Einführung in LibreOffice des Handbuchs 
Erste Schritte beschrieben.

◦ Symbolleiste fixieren - das Fixieren einer angedockten Symbolleiste lässt deren 
Griff verschwinden, so dass sie nicht mehr abgerissen werden kann.

Der Befehl Sichtbare Schaltflächen öffnet ein weiteres Menü, das in Abbildung 3 (auf 
Seite 10, die in zwei Teile zerschnitten dargestellt ist).
Hier werden alle für die Symbolleiste verfügbaren Befehle angezeigt, wobei die in der 
Symbolleiste sichtbaren markiert sind. Durch Anklicken/Auswählen können Sie einen Befehl 
in der Symbolleiste anzeigen oder diesen aus ihr entfernen.
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Abbildung 3: Das Untermenü Sichtbare Schaltflächen der Symbolleiste Zeichnung

Allgemeines zum Einfügen von Formen

Einfügen
Das Grundprinzip des Vorgehens für das Einfügen einer Form ist das folgende:

1. Wählen Sie das Symbol für das Zeichnen einer Form aus, indem Sie
◦ das Menü Form beziehungsweise Form > Einfügen und dann die gewünschte 

Form wählen oder
◦ das entsprechende Symbol aus der Symbolleiste Zeichnung auswählen oder
◦ in der Seitenleiste das Register Formen (Alt+5) wählen (Draw Seitenleiste Eigen-

schaften mit Legende auf Seite 34).
2. Positionieren Sie den Cursor an der Stelle, an der das Objekt beginnen soll, d.h. den 

Startpunkt einer Linie oder eine Ecke des zwei- oder dreidimensionalen Objekts bzw. 
bei komplizierteren Objekten des dieses einschließenden Rechtecks.

3. Klicken Sie die linke Maustaste und halten Sie sie gedrückt.
4. Bewegen Sie die Maus an den gewünschten Endpunkt der Linie oder den gegenüber-

liegenden Eckpunkt des einschließenden Rechtecks und lassen Sie die Maustaste los.
Im Normalfall werden die Start- und Endpunkte einer Linie bzw. die Ecken des einschließen-
den Rechtecks am Raster gefangen. Das heißt, dass sie beim Klicken oder Loslassen der 
Maustaste automatisch auf den nächstgelegenen Rasterpunkt verschoben wird. Sie können 
dieses Verhalten ändern, indem Sie Ansicht > Fanglinien > Am Raster fangen deaktivieren. 
Das gilt für das aktive Dokument.
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Wenn Sie das grundsätzlich ändern wollen, können Sie über Extras > Optionen > 
LibreOffice Draw > Raster > Am Raster fangen das Verhalten ändern.
Dieses Thema wird vertieft behandelt in Kapitel 3 – Objekte und Objektpunkte des Draw 
Handbuchs.

Tipp

Ein bewährtes Mittel, um neue Objekte mit gewünschten Eigenschaften zu 
erzeugen, ist das Kopieren bereits vorhandener passender Objekte. Wählen Sie 
dazu eine Linie oder ein sonstiges Objekt mit passenden Eigenschaften aus, 
drücken Sie Strg+C und dann Strg+V oder gleich wirkend Kopieren und dann 
Einfügen. Das neue Objekt ist dann markiert und kann verschoben werden. 
Oder halten Sie Strg gedrückt, während Sie das Objekt „verschieben“, dadurch 
wird eine Kopie des Objekts erzeugt und anschließend verschoben; 
Voraussetzung dafür ist, dass unter Extras > Optionen > LibreOffice Draw > 
Allgemein > Einstellungen Kopie beim Verschieben aktiviert ist, was 
standardmäßig der Fall ist.

Varianten des Einfügens
Bei den meisten Typen von Formen können Sie die folgende Möglichkeit beim Einfügen 
nutzen:

• Wenn Sie Linien zeichnen wollen, die nur einen Winkel verwenden, der ein Vielfaches 
von 45° darstellt (das heißt, anders ausgedrückt, dass Sie nur waagrechte, 
senkrechte und diagonale Linien zeichnen wollen) oder Formen, deren einschließen-
des Rechteck ein Quadrat ist (also insbesondere, wenn Sie Kreise und Quadrate 
zeichnen wollen mit den Symbole Rechteck und Ellipse), dann halten Sie die 
Umschalt-Taste beim Ziehen mit der Maus gedrückt.

Hinweis

Das ist das standardmäßige Verhalten von Draw. Sie können das aber 
umdrehen, indem Sie über Extras > Optionen... > LibreOffice Draw > Raster > 
Objekte beschränken > Beim Erzeugen und Bewegen den Haken setzen. Dann 
werden standardmäßig 45°-konforme Linien oder quadratisch einge-
schlossene Objekte gezeichnet, abweichendes Verhalten können Sie dann 
wiederum durch Verwenden der Umschalt-Taste erreichen.

Hinweis

In einigen wenigen Fällen ist das Verhalten gerade umgekehrt. Wenn Sie 
nämlich bereits eine spezielle Form eines allgemeinen Typus gewählt haben, 
also beispielsweise ein Quadrat oder einen Kreis, dann wird bei Verwendung 
der Umschalt-Taste ein Rechteck oder eine Ellipse.

Mehrfaches Einfügen des gleichen Objekttyps
Wenn Sie in der Symbolleiste Zeichnung ein Symbol ausgewählt und dann die gewünschte 
Form gezeichnet hatten, ist automatisch wieder das Auswahl-Werkzeug aktiviert, was in 
vielen Fällen auch das passende Verhalten ist. Wenn Sie aber mehrere Formen des gleichen 
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Objekttyps nacheinander einfügen wollen, klicken Sie einfach vor dem ersten Einfügen ein 
zweites Mal auf das Symbol. Dadurch ist es permanent aktiviert. Sie können die permanente 
Aktivierung beenden durch einen Klick auf das Auswahl-Symbol der Symbolleiste oder die 
Esc-Taste.

Einfügen durch Kopieren
Bequem können Sie ein Objekt einfügen, wenn die Zeichnung bereits ein ähnliches enthält, 
indem Sie dieses kopieren.
Die schnellste Möglichkeit ist, die Strg-Taste gedrückt zu halten, während Sie ein Objekt 
anklicken und dann die Maus verschieben: dabei wird eine Kopie erzeugt, die verschoben 
wird, bis Sie die Maustaste loslassen.
Eine andere Möglichkeit, insbesondere auch für das Kopieren von einem Dokument in ein 
anderes, besteht in der Verwendung von Strg+C und Strg+V (oder der Befehle Kopieren und 
Einfügen aus dem Menü Bearbeiten). Die Kopie liegt dann an der gleichen Position wie die 
Quelle, und somit, wenn Sie sie auf der gleichen Folie einfügen, exakt über der Quelle. 
Dieses Verfahren ist insbesondere günstig, wenn das kopierte Objekt in waagrechter oder 
senkrechter Richtung genauso ausgerichtet sein soll wie die Quelle. Sie können dann die 
Verschiebung in der gewünschten Richtung anschließend einfach mit den entsprechenden 
Pfeil-Tasten ausführen.
Auch mit Hilfe des Navigators (siehe Kapitel 3 – Objekte und Objektpunkte des Draw Hand-
buchs) können Sie Objekte kopieren: Klicken-ziehen Sie das Objekt aus dem Navigator auf 
die gewünschte Folie und lassen die Maustaste los. Damit wird eine Kopie erzeugt. Dieses 
Verfahren können Sie auch für das Kopieren eines Objekts von einem Dokument in ein 
anderes nutzen, innerhalb eines Dokuments funktioniert es nur beim Kopieren auf die 
gleiche Folie.

Ändern der eingefügten Form
Sie können natürlich die Eigenschaften der gerade eingefügten Form jederzeit beeinflussen. 
Die dazu notwendigen Informationen finden Sie in Kapitel 3 – Objekte und Objektpunkte 
des Draw Handbuchs, was die geometrischen Eigenschaften betrifft, beziehungsweise in 
Kapitel 4 – Objekteigenschaften ändern dieses Handbuchs für die restlichen Eigenschaften.

Formen benennen
Eine eingefügte Form erhält – wie auch andere eingefügte Objekte – zwar einen von 
LibreOffice vergebenen Namen, der aber bei Formen einfach aus „Form“ und einer laufen-
den Nummer besteht. Sie können über Format > Name… dem Objekt stattdessen einen 
aussagekräftigen Namen geben. In vielen Fällen wird dies zwar nicht nötig sein, aber wenn 
Sie den Navigator (siehe Kapitel 3 – Objekte und Objektpunkte des Draw Handbuchs) benut-
zen wollen, um Objekte zu selektieren, dann ist das Voraussetzung, das funktioniert nicht 
gut mit den vom System vergebenen Namen.
Auch wenn Sie per Programm auf die Objekte zugreifen wollen, ist ein sprechender Name 
notwendig, Programmierung ist allerdings nicht das Thema dieses Handbuchs.
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Technischer Hintergrund
Zum Teil aufgrund ihrer konstruktiven Eigenschaft, zum Teil aber auch aus der historischen 
Entwicklung heraus basieren die Formen auf verschiedenen technischen Konzepten, deren 
Auswirkungen Ihnen oft verborgen bleiben werden, die sich aber manchmal doch am 
Verhalten zeigen.
Als grundlegende Typen gibt es Linie, Rechteck und Ellipse, daneben aufgrund gänzlich 
anderer Konstruktionsgrundlagen Bézierkurven und Polygone.
Um komplexere Formen anbieten zu können, wurde ein allgemeineres Konzept realisiert, die 
internen Custom Shapes (etwa „maßgeschneidert“ oder „passgenau“) genannten Formen, 
der Begriff taucht an der Oberfläche nicht auf; dadurch wurden Formen wie die in 
Abbildung 4 gezeigten möglich. Das hat auch den Vorteil, dass Entwickler weitere Formen 
zur Verfügung stellen können, die Sie über die Galerie oder per Ziehen und Ablegen bequem 
verwenden können (siehe Kapitel  11 – Grafik, Galerie und Fontwork des Handbuchs Erste 
Schritte oder auch Kapitel 11 – Fortgeschrittene Zeichentechniken des Draw Handbuchs).

Abbildung 4: Beispiele für Custom Shapes

Als Konsequenz werden nun auch die von Rechteck und Ellipse abgeleiteten Formen im 
Wesentlichen als Objekte auf dieser Basis angeboten; die entsprechenden Objekte, die mit 
der älteren Technik arbeiten, sind über die Symbolleisten Rechtecke (veraltet) und Kreise 
und Ellipsen (veraltet) weiter verfügbar, werden aber standardmäßig nicht angeboten, wie 
auch der Hinweis im Namen nahelegt. Sie können diese Symbolleisten über Ansicht 
> Symbolleisten bei Bedarf aktivieren.
Eine Ausnahme bilden zwei Symbole, die auch in der Symbolleiste Grundformen 
enthalten sind, nämlich Kreissegment (Abbildung 5 a) und Ellipsenbogen 
(Abbildung 5 b), (siehe Seite 24), für die es offenbar keine Realisierung als „Custom 
Shape“ gibt. Sie verwenden noch die ältere Technik und finden sich genauso in der 
veralteten Symbolleiste.

Gerade Linien, Pfeile und Linienspitzen
Die Überschrift beinhaltet sowohl einfache Linien ohne Besonderheit an den Endpunkten wie 
auch Pfeile und andere Linien mit Linienspitzen. Sie können die Linienspitzen einer Linie 
später jederzeit ändern, daher ist es – bis auf wenige Ausnahmen – auch ziemlich egal, ob 
Sie mit einer einfachen Linie oder einem der Typen beginnen, die über das Symbol Linien 
und Linienspitzen (siehe Linientyp auf Seite 14) angeboten werden.

Zeichnen einer Linie
Das Grundprinzip des Vorgehens wurde bereits in Einfügen auf Seite 10 beschrieben.
Der Startpunkt einer Linie ist mit einem etwas größeren, der Endpunkt mit einem etwas 
kleineren Quadrat markiert (Abbildung 6 auf Seite 14).
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Abbildung 6: Linie mit Start- 
und Endpunkt

Linientyp
In der Symbolleiste Zeichnung können Sie eine einfache Linie ohne besondere Linienenden 
direkt über das Symbol Linie einfügen einfügen oder über die Abreißleiste Linien und Linien-
spitzen. Im zweiten Fall konnten Sie bereits aus einem Angebot verschiedener Linientypen 
wählen, das einige häufig benötigte Kombinationen der Linienspitzen für Anfang und Ende 
bereitstellt. Abbildung 7 zeigt links die Abreißleiste im angedockten und rechts im abgeris-
senen Zustand.

Abbildung 7: Symbolleiste Linien und Linienspitzen angedockt (links) und abgerissen (rechts)

Im abgerissenen Zustand zeigt die Abreißleiste den einschränkenden Titel „Linie und...“.
Der Vorteil der abgerissenen Palette ist, dass sie geöffnet bleibt; Sie können das ausnutzen, 
wenn Sie eine größere Anzahl von Linien zeichnen möchten. Irgendwann ist die Palette dann 
wahrscheinlich im Weg, schließen Sie sie dann einfach, sie können später wieder die 
angedockte Palette durch Anklicken des Symbols in der Symbolleiste Zeichnung öffnen.
Sie können die abgerissene Palette aber beispielsweise am rechten Rand mit der Maus 
fassen (ein waagerechter Doppelpfeil der Maus ist zu sehen) und nach rechts ziehen, sodass 
die Palette die Form einer waagerechten Symbolleiste bekommt, in der der Titel vollständig 
zu lesen ist (Abbildung 8).

Abbildung 8: Palette nun als Symbolleiste

Das angezeigte Symbol Linien und Linienspitzen in der Symbolleiste Zeichnung (links oben 
im linken Bild in Abbildung 7) ändert sich übrigens je nach der letzten von Ihnen vorgenom-
menen Auswahl; der Standard bei einem neuen Dokument ist der Pfeil, wie er links oben im 
rechten Bild in Abbildung 7 gezeigt wird. Das ermöglicht Ihnen, bei angedockter Palette den 
zuletzt ausgewählten Typ der Linie durch einfaches Anklicken des Symbols zu wählen, ohne 
die Palette öffnen zu müssen.
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Sie können auch das Symbol, das Sie benötigen ein zweites mal anklicken, um dieses Objekt 
mehrfach direkt hintereinander zeichnen zu können. Beenden Sie dann mit der Taste Esc.

Eigenschaften der Linie
Eine erzeugte Linie hat zunächst die standardmäßig festgelegten Eigenschaften. Diese 
können Sie, abgesehen vom Linientyp, über das Symbol Linien und Linienspitzen der 
Symbolleiste Zeichnung, auch nicht direkt beeinflussen. Sie können aber anschließend die 
erzeugte Linie selektieren und über Kontextmenü Linie oder über Format mit seinen diver-
sen Untermenüs oder über die Seitenleiste ihre Eigenschaften verändern (Weiteres zur 
Seitenleiste wird im Kapitel 1 – Einführung in LibreOffice des Erste Schritte Handbuchs 
näher beschrieben.).
Insbesondere ermöglichen Format > Linie, Kontextmenü Linie oder der Bereich Linie in 
der Seitenleiste die Veränderung der linienspezifischen Eigenschaften.

Maßlinien
Ein Sonderfall der Linie ist die Maßlinie (Abbildung 9).
Sie dient dazu, die Dimensionen eines Objekts anzuzeigen, die Zahlengabe wird automatisch 
von LibreOffice berechnet. Einzelheiten zu Maßlinien finden Sie in Kapitel 11 – 
Fortgeschrittene Zeichentechniken des  Draw Handbuchs.

Abbildung 9: Maßlinien

Kurven und Polygone
Abbildung 10 zeigt die Symbolleiste für Kurven und Polygone und deren Erläuterung.

Abbildung 10: Symbolleiste Polygone
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1. Gefüllte Kurve
2. Gefülltes Polygon
3. Gefülltes Polygon (45°)
4. Gefüllte Freihandlinie

5. Kurve
6. Polygon
7. Polygon (45°)
8. Freihandlinie

Die Objekte dieser Symbolleiste können jeweils gefüllt oder ungefüllt sein; präziser gesagt:
• ein gefülltes Objekt ist geschlossen und hat eine Füllung
• ein ungefülltes Objekt ist (zunächst) nicht geschlossen und hat keine Füllung

Den Unterschied zeigt Abbildung 11:

Abbildung 11: ungefüllt / gefüllt

Sie zeigt den gleichen Linienzug, links „ungefüllt“, rechts „gefüllt“. Bei einem gefüllten 
Objekt wird immer die Linie vom derzeitigen Endpunkt (unten) zum Anfangspunkt (oben) 
automatisch hinführt (die rote Linie im rechten Bildteil).

Hinweis

Auch nicht geschlossene Objekte können in manchen Fällen gefüllt werden, 
beispielsweise die Klammern, die bei den Symbolformen zu finden sind.

Ein ungefülltes Objekt kann man schließen, indem man Kontextmenü Objekt schließen 
aufruft. Dann wird im Beispiel der Abbildung 11 die (hier rot dargestellte) Linie ergänzt. Bei 
komplizierteren Linienführungen können sich dabei durchaus interessante Ergebnisse 
zeigen. Die zugrundeliegende Regel wird im Abschnitt Kombinieren des Kapitel 5 – Mehrere 
Objekte des Draw Handbuchs erläutert. Anschließend können Sie es auch füllen über 
Kontextmenü Fläche oder Format > Fläche

Vorsicht

Versuchen Sie nicht, das Objekt selbst beim Zeichnen zu schließen, indem Sie 
das letzte Liniensegment zum Anfangspunkt zurückführen; es wird zwar, wenn 
Sie sich dabei dem Anfangspunkt genügend nähern, automatisch geschlossen, 
in aller Regel wird aber ein weiteres, ziemlich kleines Segment ergänzt, weil Sie 
wahrscheinlich den Ausgangspunkt nicht exakt treffen werden. Abbildung 12 
auf Seite 17 zeigt links einen solchen Fall, nur bei genauem Hinsehen entdeckt 
man eine kleine Unregelmäßigkeit in der linken oberen Ecke, die starke 
Vergrößerung rechts zeigt die Ursache, zwei nahe beieinander liegende Punkte.
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Abbildung 12: manuell geschlossenes 
Polygon – rechts vergrößert

Sie können ein geschlossenes ungefülltes Objekt erhalten, indem Sie der Fläche die Art der 
Füllung Ohne zuweisen.

Freihandlinie
Die Handhabung ist sehr einfach, aber es ist nicht unbedingt leicht, das gewünschte 
Ergebnis zu erzielen, weil die Bewegung mit der Maus gut gesteuert werden muss.

1. Wählen Sie das Menü Form > Einfügen > Kurven und Polygone > Freihandlinie oder 
das Symbol Freihandlinie in der Symbolleiste Zeichnung.

2. Klicken Sie auf das Arbeitsblatt auf eine freie Stelle um den Startpunkt der Linie zu 
setzen.

3. Ziehen Sie weiter bei gedrückter Maustaste mit dem Cursor, um die Begrenzungslinie 
der gewünschten Form zu zeichnen.

4. Doppelklicken Sie, wenn Sie den Endpunkt erreicht haben.

Polygone
Dies umfasst die Fälle Polygon und Polygon (45°), jeweils gefüllt und ungefüllt. Die Fälle mit 
(45°) unterscheiden sich von den anderen beiden nur dadurch, dass der Winkel der erzeug-
ten Linien immer ein Vielfaches von 45° beträgt, was häufig eine Erleichterung beim Zeich-
nen von Formen bedeutet.
Um ein solches Polygon zu zeichnen:

1. Wählen Sie das entsprechenden Menü oder das entsprechende Symbol.
2. Klicken Sie am Startpunkt des ersten Segments des Polygons.
3. Ziehen Sie bei gedrückter Maustaste den Cursor zum Endpunkt des ersten Segments: 

eine Linie wird gezeichnet.
4. Lassen Sie die Maustaste los.
5. Bewegen Sie den Cursor zum gewünschten Endpunkt des nächsten Segments: eine 

weitere Linie wird gezeichnet.
6. Klicken Sie, um den Endpunkt zu fixieren und wiederholen Sie Schritt 5, wenn Sie 

weitere Segmente zeichnen wollen oder doppelklicken Sie, um das Zeichnen des 
Polygons abzuschließen.

Hinweis

Die Statusleiste zeigt an, dass es sich um ein Polygon handelt und nennt die 
Anzahl der Punkte.
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Kurven
Die Kurven, die mit diesem Werkzeug gezeichnet werden, sind Bézierkurven; hier wird 
zunächst nur das Zeichnen einer solchen Kurve (ohne Füllung) gezeigt, um die Übersicht der 
verfügbaren Formen zu ergänzen. Näheres zur Arbeit mit Bézierkurven finden Sie in Kapitel 
11 – Fortgeschrittene Zeichentechniken des Draw Handbuchs.
Abbildung 13 zeigt den Ablauf des Zeichnens einer solchen Kurve und einer ersten 
Änderung. Erst der zweite und dritte Schritt lassen erkennen, warum die Linie im ersten 
Schritt so gezogen wurde. Zunächst klicken Sie auf das Symbol Kurve und:

a) ziehen Sie eine waagrechte Linie, indem Sie bei 1 klicken und die Maustaste halten-
ziehen und bei 2 die Taste loslassen (Abbildung 13).

b) bewegen Sie die Maus nach links unten (der rote Pfeil zeigt die  angedeutete Cursor-
bewegung), damit Sie an dem Punkt anlangen, wie die zweite Grafik das zeigt. 
Doppelklicken Sie dann, damit die Kurve abgeschlossen wird.

c) Der dritte Teil der Abbildung zeigt nun die Struktur der erzeugten Kurve: Beginn und 
Ende der Kurve haben als Tangente die Geraden, die von den Anfangs- und Endpunk-
ten zu dem Punkt 2 verlaufen. Es ist eine der Charakteristiken der Bézierkurven, dass 
das Verhalten an ihren Punkten durch Tangenten bestimmt ist.

Abbildung 13: Zeichnen einer Kurve - Teil a), b), c)

d) Abhängig vom Punktbearbeitungsmodus sehen Sie die ausgewählte Kurve als Objekt 
mit den acht Ziehpunkten am umschließenden Rechteck (Modus aus) oder mit zwei 
Ziehpunkten am Anfang und Ende der Kurve (Modus ein) (Abbildung 14 auf Seite 19). 
Die weitere Bearbeitung ist also vom Punktbearbeitungsmodus abhängig. Im Modus 
aus können Sie die Breite und Höhe der Kurve verändern. Wenn Sie jedoch die Form 
der Kurve verändern wollen, muss der Modus eingeschaltet sein. Den Punktbearbei-
tungsmodus schalten Sie über das Kontextmenü Punktbearbeitungsmodus umschal-
ten oder über die Symbolleiste Standard und das Symbol Punktbearbeitungsmodus 
umschalten oder die Taste F8 ein oder aus.
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Abbildung 14: Zeichnen einer Kurve - 
Teil d)

e) Ist der Punktbearbeitungsmodus eingeschaltet, zeigt der Cursor, wenn der Mauszei-
ger sich einem Endpunkt nähert, als Symbol einen Pfeil mit einem Quadrat, als 
Zeichen, dass der Punkt verschoben wird, wenn Sie ihn anklicken und die Maus 
bewegen.

Abbildung 15: 
Zeichnen einer 
Kurve - Teil e)

f) Wenn Sie allerdings den Anfangspunkt der Kurve anklicken und die Maustaste loslas-
sen, erscheint ein durch einen Kreis symbolisierter Punkt mit einer Linie zu diesem 
Endpunkt. Der Endpunkt dieser Linie (bei 2) wird Steuerpunkt genannt, weil er das 
Verhalten der Kurve in diesem Punkt steuert.
Durch eine Änderung der Richtung dieses Punktes ändert sich die Austrittsrichtung 
der Kurve, die Länge der Linie bestimmt die Krümmung.
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Abbildung 16: Zeichnen 
einer Kurve - Teil f)

g) Bei der Kurve ist der Endpunkt (nun im Sinne des Zeichnens: das „Ziel“, 
das durch ein kleineres Quadrat gekennzeichnet ist). Im Gegensatz zum 
Anfangspunkt liegt der zweite Steuerpunkt allerdings genau auf dem 
Endpunkt , was man bei genauem Hinschauen auch bemerken kann. 
Wenn Sie auf diesen Endpunkt zeigen, ändert sich das Cursor-Symbol 
zu einem Pfeil mit Symbol entsprechend Abbildung 17. Wenn Sie nun mit 
gedrückter Maustaste die Maus bewegen, wird die zugehörige Linie 
sichtbar und Sie können die Richtung, mit der die Kurve den Endpunkt 
verlässt, sowie die Form der daraus resultierenden Kurve bestimmen.

Abbildung 18: Zeichnen 
einer Kurve - Teil g)

Wenn Sie in b) nicht doppelklicken sondern einfach klicken-halten-ziehen, loslassen und 
ziehen und dann doppelklicken, können Sie die Kurve weiter zeichnen, wie Sie damit weiter 
umgehen können, finden Sie in Kapitel 11 – Fortgeschrittene Zeichentechniken des Draw 
Handbuchs.

Verbinder
Verbinder können auf vielfältige Weise jeweils zwei Formen miteinander verbinden und 
werden in Kapitel 8 – Verbinder, Fluss- und Organisationsdiagramme des Draw Handbuchs 
im Zusammenhang mit Klebepunkten beschrieben.

Verbinder 20
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Grundformen
Die Symbolleiste Grundformen (Abbildung 19):

Abbildung 19: Symbolleiste Grundformen

Diese Symbole bieten eine Vielzahl von etwas anspruchsvolleren Formen, zum Teil mit 
Möglichkeiten zur weiteren Beeinflussung des Aussehens, wie sie bei Rechteck und Ellipse 
gar nicht auftreten (Abbildung 20).
Die einzelnen Symbole werden im Folgenden entsprechend der Darstellung in Abbildung 20 
beschrieben; in der Symbolleiste entspricht das der Reihenfolge von links nach rechts.

Abbildung 20: Die Werkzeuge der Symbolleiste Grundformen

Die allgemeine Größenänderung erfolgt wie üblich über die acht Ziehpunkte des die Form 
umgebenden Rechtecks (vier Eckziehpunkte, vier Ziehpunkte mittig der Seiten) in Form 
kleiner Quadrate.

Kontrollpunkte
Viele der Formen enthalten neben den acht Ziehpunkten bei 
geschlossenen Objekten noch einen oder zwei Kontrollpunkte 
(Abbildung 21), manche sogar drei (Abbildung 22), die durch 
graue Punkte dargestellt werden. Sie ermöglichen die 
Änderung weiterer Parameter der Form, wie Eckenradius, 
Öffnungswinkel und so weiter. Manche dieser Kontrollpunkte 
ändern den Parameterwert um einen festen Wert abhängig 
von der Verschiebung des Kontrollpunktes, andere tun dies 
proportional zu den Dimensionen des umschließenden Rechtecks; daher 
ändert der Kontrollpunkt im ersten Fall eventuell seinen Platz, wenn das 
Verhältnis zwischen Breite und Höhe des umgebenden Rechtecks sich 
ändert.
In manchen Fällen (wenn es sich nicht um ein Custom Shape handelt) 
sehen Sie die Kontrollpunkte nur, wenn Sie den Punktbearbeitungsmodus 
einschalten über das Menü Bearbeiten > Punktbearbeitungsmodus umschalten oder über 
das Symbol Punktbearbeitungsmodus umschalten auf der Symbolleiste Standard oder F8.
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Rechteck
Zeichnet ein Rechteck, bei zusätzlicher Verwendung der Umschalt-Taste wird ein Quadrat 
gezeichnet.

Abgerundetes Rechteck
Im Vergleich zum Rechteck besitzt dieses Objekt einen zusätzlichen 
Kontrollpunkt (siehe Seite 21 Kontrollpunkte), auf den das geänderte 
Cursorsymbol der Hand in der Abbildung 23 deutet, mit dem Sie die 
Größe der Abrundung der Ecke beeinflussen können. Der Kontroll-
punkt befindet sich entweder auf der oberen oder auf der linken 
Kante des Rechtecks, je nachdem, welche von beiden länger ist. 
Bewegen Sie diesen Kontrollpunkt mit der Maus, um die Größe der 
Abrundung zu verändern.
Über Kontextmenü oder Format > Position und Größe > Schrägstellen/Eckenradius lässt sich 
der Eckenradius ebenfalls festlegen. Dazu wird allerdings nicht das Feld Eckenradius 
verwendet, das nur für Formen vom alten Typus (siehe Technischer Hintergrund auf Seite 13) 
aktiv ist, sondern er wird über die Felder zum Kontrollpunkt 1 gesteuert, entsprechend wie 
Sie ja auch diesen Kontrollpunkt mit der Maus verschieben. Sie geben hier in der Variablen 
X: oder Y: (nur die zutreffende ist aktiv) den Abstand des Kontrollpunkts vom Eckpunkt an, 
was gleichzeitig auch der Radius der Rundung ist.

Quadrat
Zeichnet ein Quadrat, bei zusätzlicher Verwendung der Umschalt-Taste wird ein Rechteck 
gezeichnet.

Abgerundetes Quadrat
Das Verhalten ist das gleiche wie in Abgerundetes Rechteck auf Seite 22.

Parallelogramm
Das Verhalten ist ganz ähnlich wie in  Abgerundetes Rechteck auf Seite 22, jedoch bewirkt 
die Verschiebung des Kontrollpunkts (siehe Seite 21 Kontrollpunkte) hier die Veränderung 
der Neigung des Parallelogramms.
Um ein zur anderen Seite geneigtes Parallelogramm zu erhalten, spiegeln Sie es.

Trapez
Das Verhalten ist ganz ähnlich wie in Abgerundetes Rechteck auf Seite 22, jedoch bewirkt 
die Verschiebung des Kontrollpunkts (siehe Seite 21 Kontrollpunkte) hier die Veränderung 
der Breite der (schmäleren) Basis des Trapezes und damit natürlich auch der Neigung von 
dessen Seiten. Die Breite der oberen Kante können Sie einfach über die standardmäßigen 
Ziehpunkte des umrahmenden Rechtecks verändern. Sie können die hier schmälere Basis 
nicht über die Größe der breiteren oberen Kante hinaus verlängern; wenn Sie die breitere 
Basis unten benötigen, spiegeln Sie einfach das Trapez vertikal.
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Ellipse
Zeichnet eine Ellipse, bei zusätzlicher Verwendung der Umschalt-Taste wird ein Kreis 
gezeichnet.

Kreis
Zeichnet einen Kreis, bei zusätzlicher Verwendung der Umschalt-Taste eine Ellipse.

Kreissektor
Über den beiden Seitenmittelpunkten oben und rechts liegen Kontroll-
punkte (siehe Seite 21 Kontrollpunkte), mit denen Sie die Öffnung der 
Kreisfläche verändern können (Abbildung 24).
Wenn Sie beim Erzeugen der Form die Umschalt-Taste zusätzlich 
gedrückt halten, wird ein Ellipsensektor erzeugt.
Sie können die beiden Kontrollpunkte auch über Kontextmenü oder 
Format > Position und Größe > Neigung/Eckenradius verändern: für 
jeden der beiden Punkte ist die x- und y-Koordinate angegeben 
(Abbildung 25).
Wenn Sie einen möglichst exakten Winkel erreichen wollen, empfiehlt es sich, zunächst eine 
radiale Hilfslinie zu zeichnen (beim Zeichnen wird der Winkel in der Statusleiste angezeigt) 
und dann bei ziemlich großer Vergrößerung den Kontrollpunkt auf dieser Hilfslinie platzieren.

Abbildung 25: Dialog Position und Größe -

Kreissegment
Hier zeichnen Sie zunächst einen 
Kreis in der gewünschten Größe; 
wenn Sie diese Phase durch einen 
Klick abschließen, wird der Kreis in 
der Form, wie er im linken Teil, der 
Abbildung 26 sichtbar ist, darge-
stellt. Die angezeigte radiale Linie 
wird durch die Cursorbewegung 
verschoben, wobei der Mauszeiger 
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sich nicht auf der Kreislinie befinden muss, es kommt nur auf die Richtung zum Mittelpunkt 
an. Während Sie die Maus bewegen, wird in der Statusleiste der jeweilige Winkel angezeigt. 
Wenn Sie klicken (im Beispiel wurde der am weitesten rechts liegende Punkt des Kreises 
gewählt), wird da, wo diese radiale Linie auf den Rand des Kreises trifft, der Anfangspunkt 
des Kreissegments gesetzt. Bewegen Sie nun den Cursor, um den zweiten Punkt zu bestim-
men, der das Segment festlegt und klicken Sie erneut. Das Ergebnis ist eine Form, wie sie im 
mittleren Teil der Abbildung 26 erscheint. Das übrigbleibende Segment ist der Teil des 
Kreises rechts von der Linie zwischen dem Anfangspunkt und diesem zweiten Punkt, wenn 
die Linie in dieser Richtung durchlaufen wird. Rechts in der Abbildung 26 das Kreissegment 
mit den umrandenden Ziehpunkten und den zwei Kontrollpunkten.
Auch in diesem Fall wird ohne Umschalt-Taste ein Kreis gezeichnet, mit  Umschalt-Taste 
eine Ellipse.

Ellipsenbogen
Hier gilt das gleiche Vorgehen wie in Kreissegment auf Seite 19, nur dass das Ergebnis ein 
Abschnitt auf der Ellipsenlinie ist. Die Umschalt-Taste verhält sich hier wieder wie in Varian-
ten des Einfügens auf Seite 10 beschrieben.
Diese Form basiert genau wie die vorige auf der älteren Technik, das dort Gesagte gilt 
entsprechend.

Halbbogen
Dieser Befehl erzeugt einen Halbbogen, der entsprechend dem Verhältnis von Höhe und 
Breite des dieses Objekt umrahmenden Rechtecks dargestellt wird. Der zusätzlich Kontroll-
punkt ermöglicht sowohl, die Breite des Bogens festzulegen (waagrechte Ziehrichtung), als 
auch zu bestimmen, wie weit der Bogen geöffnet oder geschlossen ist (senkrechte 
Ziehrichtung).

Gleichschenkliges Dreieck
Dieser Befehl erzeugt ein gleichschenkliges Dreieck. Der Kontrollpunkt (siehe Seite 21 
Kontrollpunkte) oben in der Mitte erlaubt es, die obere Ecke zu verschieben (wodurch das 
Dreieck natürlich nicht mehr gleichschenklig ist).

Rechtwinkliges Dreieck
Erzeugt ein rechtwinkliges Dreieck, bei Einsatz der Umschalt-Taste ein gleichschenklig-
rechtwinkliges Dreieck, also ein diagonal halbiertes Quadrat.

Raute
Der Befehl erzeugt eine Raute, bei Einsatz der Umschalt-Taste eine mit rechten Winkeln, was 
das selbe wie ein auf der Spitze stehendes Quadrat ist.
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Fünfeck
Es wird ein Fünfeck mit einer waagerechten Kante unten erzeugt, bei Einsatz der Umschalt-
Taste, dessen umschließendes Rechteck ein Quadrat ist. Ansonsten entsteht ein Fünfeck, bei 
dem die waagrechte und die senkrechte Ausdehnung sich unterscheiden.

Sechseck
Das Verhalten ist genauso wie beim Fünfeck. Das Sechseck enthält zusätzlich noch einen 
Kontrollpunkt (siehe Seite 21 Kontrollpunkte), mit dem sich der Winkel der nicht waagrech-
ten Kanten verändern lässt.

Achteck
Auch dieses verhält sich ähnlich wie das Sechseck. Der Kontrollpunkt (siehe Seite 21 
Kontrollpunkte) bewirkt hier, ähnlich wie beim abgerundeten Rechteck und Quadrat, eine 
Änderung der Größe der „abgeschnittenen Ecken“.

Zylinder
Erzeugt einen stehenden Zylinder (in isometrischer Darstellung). Der Kontrollpunkt (siehe 
Seite 21 Kontrollpunkte) ermöglicht es, die Neigung der Draufsicht zu verändern.

Würfel
Ein Würfel wird nur bei Verwendung der Umschalt-Taste erzeugt (oder wenn das umgeben-
de Rechteck ein Quadrat ist), ansonsten ist es im Allgemeinen ein Quader. Der Winkel, mit 
dem die z-Achse dargestellt wird, beträgt 45°. In Richtung der x- und y-Achse kann man 
den Quader verlängern oder verkürzen, indem man einen der acht Eck- und Seitenmittel-
punkte verschiebt, der zusätzliche Kontrollpunkt (siehe Seite 21 Kontrollpunkte) verändert 
die Größe der Stirnfläche, der Quader erscheint in Richtung der z-Achse damit im Verhältnis 
zur Stirnfläche länger oder kürzer (Abbildung 27).

Abbildung 27: Verformung eines Quaders in Richtung der drei Achsen

Gefaltete Ecke
Der Befehl erzeugt das Bild eines Blattes mit umgeklappter Ecke, der Kontrollpunkt (siehe 
Seite 21 Kontrollpunkte) ermöglicht die Größenänderung der Ecke.
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Kreuz
Der Befehl erzeugt eine kreuzförmige Fläche, der Kontrollpunkt (siehe Seite 21 Kontroll-
punkte) dient dazu die Breite der Kreuzarme zu verändern. Die waagrechten und die 
senkrechten Arme werden beide um den gleichen Wert verbreitert oder verschmälert, 
maximal, bis die Dimension mit dem schmäleren Arm die Breite 0 erhält.

Rahmen
Der Befehl zeichnet einen rechteckigen Rahmen, der Kontrollpunkt (siehe Seite 21 Kontroll-
punkte) ermöglicht es, dessen Breite zu verändern.

Ring
Der Befehl zeichnet einen Ring, dessen Breite durch den Kontrollpunkt (siehe Seite 21 
Kontrollpunkte) verändert werden kann. Hier wird wieder ohne Umschalt-Taste ein Kreisring, 
mit dagegen ein Ellipsenring gezeichnet. Die Größenänderung des Rings erfolgt proportional 
zur Höhe bzw. Breite, daher muss der Kontrollpunkt seinen Platz nicht wechseln.

Symbolformen
Die Symbolleiste Symbolformen (Abbildung 28):

Abbildung 28: Symbolleiste Symbolformen

In Abbildung 29 sind die Symbolformen dargestellt und beschrieben:

Abbildung 29: Die Symbolformen

Die Mehrzahl der Formen besitzt auch wiederum Kontrollpunkte (siehe Seite 21 Kontroll-
punkte), deren Funktion ähnlich wie bei den Grundformen ist (siehe Kontrollpunkte auf Seite 
21 und die eventuellen Ergänzungen bei den einzelnen Grundformen).
Da auch das sonstige Verhalten dem der Grundformen vergleichbar ist, werden die Symbol-
formen nicht weiter detailliert beschrieben.
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Blockpfeile
Die Symbolleiste Blockpfeile (Abbildung 30):

Abbildung 30: Symbolleiste Blockpfeile

In Abbildung 31 sind die Blockpfeile dargestellt und beschrieben:

Abbildung 31: Die Formen Blockpfeile

Fast alle Formen besitzen Kontrollpunkte (Seite 21). Es werden nur noch Besonderheiten 
explizit beschrieben.

• Die ersten sechs Formen besitzen jeweils einen Kontrollpunkt, der es erlaubt, sowohl 
die Breite des Pfeilbalkens wie auch die Länge des Pfeilkopfes zu ändern.

• Pfeil im Kreis: Der linke Kontrollpunkt erlaubt die Bestimmung des Endes des Pfeil-
balkens (der hier natürlich ein Ringsegment ist), der rechte ermöglicht die Änderung 
der Position der Pfeilspitze sowie der Breite des Pfeilbalkens. Wenn die Pfeilspitze das 
Ende des Balkens überlagert, ergibt sich der normalerweise hier unerwünschte 
Effekt, der beim Kombinieren zweier Formen (siehe Kapitel 05 – Mehrere Objekte des 
Draw Handbuchs) entsteht.

• Pfeil in alle Richtungen: zwei Kontrollpunkte am Pfeil nach oben. Der obere Kontroll-
punkt verbreitert die Pfeilköpfe und der untere ändert wie bei den sechs ersten 
relativ einfachen Pfeilformen sowohl die die Breite des Pfeilbalkens als auch die 
Länge des Pfeilkopfes.

• Beide Richtungspfeile: der Kontrollpunkt verändert den Winkel der Spitze.
• Gestreifter Pfeil nach rechts: wie bei den einfachen Pfeilen kann die Breite Pfeilbal-

kens wie auch die Länge des Pfeilkopfes verändert werden.
• Eingekerbter Pfeil nach rechts: zusätzlich zur Funktion bei den ersten Pfeilen wird 

auch die Einkerbung am Ende beeinflusst.
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• Legende mit Pfeil…: Hier gibt es zusätzlich zu dem von den ersten Pfeilen bekannten 
Kontrollpunkt, der die Breite des Pfeilbalkens und die Länge des Pfeilkopfes 
bestimmt, einen Kontrollpunkt, der die Breite des Pfeilkopfes festlegt (die ja nicht 
mehr durch die Gesamthöhe oder -breite der Form bestimmbar ist) und einen 
Kontrollpunkt, der das Breitenverhältnis zwischen Pfeil und Legendenblock regelt.

Flussdiagramm
Die Symbolleiste Flussdiagramm (Abbildung 32).

Abbildung 32: Symbolleiste Flussdiagramm

In Abbildung 33 sind die Flussdiagramme dargestellt und beschrieben:

Abbildung 33: Die Formen Flussdiagramme

Es werden die Symbole angeboten, die für Flussdiagramme benötigt werden. Keines der 
Symbole besitzt zusätzliche Kontrollpunkte, so dass hier keine eingehendere Beschreibung 
benötigt wird Die Direkthilfe beim Zeigen auf ein Symbol liefert bereits die erforderliche 
Information.
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Legenden
Die Symbolleiste Legenden (Abbildung 34):

Abbildung 34: Symbolleiste 
Legenden

In Abbildung 35 sind die Flussdiagramme dargestellt und beschrieben:

Abbildung 35: Die Formen Legenden

Die ersten vier Formen besitzen je einen Kontrollpunkt (siehe Seite 21 Kontrollpunkte), mit 
dem der Zeiger der Legende dem zu beschreibenden Objekt zugeordnet werden kann. Die 
anderen drei Legende mit Linie x besitzen einen zweiten Kontrollpunkt, mit dem die Position 
der Legende nachträglich verändert werden kann, wenn der Bezug zum zu beschreibenden 
Objekt bereits fixiert ist. Zwischen Legende mit Linie 1 und Legende mit Linie 3 lässt sich 
kein Unterschied feststellen. Legende mit Linie 2 besitzt eine geknickte Linie, deren Knick-
punkt sich mit dem dritten Kontrollpunkt verschieben lässt.
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Sterne und Banner
Die Symbolleiste Sterne und Banner (Abbildung 36):

Abbildung 36: Symbolleiste Sterne und Banner

In Abbildung 37 sind die Sterne und Banner dargestellt und beschrieben:

Abbildung 37: Die Formen 
Sterne und Banner

Dieses Werkzeug bietet spezielle Formen an, deren Handhabung keine zusätzlichen 
Informationen erfordern im Vergleich zu dem bereits Gesagten.

Sterne und Banner 30



3D-Objekte
Die Symbolleiste 3D-Objekte (Abbildung 38):

Abbildung 38: Symbolleiste 
3D-Objekte

In Abbildung 39 sind die Sterne und Banner dargestellt und beschrieben:

Abbildung 39: 
Die Formen 
3D-Objekte

Mit diesem Werkzeug erzeugen Sie Objekte, die dreidimensionales Verhalten darstellen. Es 
wird dazu intern eine sogenannte 3D-Szene erstellt, die tatsächlich eine dreidimensionale 
Beschreibung des Objekts enthält. Von diesem dreidimensionalen Objekt wird eine zweidi-
mensionale Projektion auf die Ansichtsebene erstellt und in das begrenzende Rechteck 
eingepasst. Die Drehpunkte dieses projizierten Objekts erlauben eine Drehung im Raum des 
Objekts, Einzelheiten finden Sie im Kapitel 07 – Arbeiten mit 3D Objekten des Draw 
Handbuchs.
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Text für Formen
Allen Formen können Sie einen Text zuweisen. Das ist die bequemste und sicherste Variante 
der Gestaltung einer Zeichnung, da dann der Text immer mit der Form verknüpft ist. In 
manchen Fällen müssen Sie allerdings auch den Text getrennt von der Form in einem 
eigenen Objekt eingeben, für das Sie allerdings dann Sorge tragen müssen, dass es 
passend zum referenzierten Objekt platziert bleibt, beispielsweise durch Gruppieren (siehe 
Kapitel 5 – Mehrerer Objekte des Draw Handbuchs).
Um einem Objekt Text zuzuweisen, wählen Sie es aus und tippen einfach den gewünschten 
Text. Wenn Sie einen bereits vorhandenen Text nur am Ende ergänzen wollen, gehen Sie 
genauso vor.
Wenn Sie einen bestehenden Text anderweitig ändern wollen, haben Sie mehrere 
Möglichkeiten:

• Doppelklicken Sie das Objekt
• Betätigen Sie bei ausgewähltem Objekt F2.
• Wenn die Schnellbearbeitung zugelassen ist (Extras > Optionen... > LibreOffice Draw > 

Allgemein > Schnellbearbeitung), dann ändert sich das Maussymbol zum Textcursor, 
wenn Sie auf den Text zeigen. Wenn Sie nun klicken, wird der Textcursor an der Stelle 
des Klicks positioniert.

Wie Sie den Text eines Zeichnungsobjekts formatieren können, wird im Kapitel 09 – Text 
einfügen und formatieren des Draw Handbuchs beschrieben, das auch die weiteren 
Möglichkeiten zur Verwendung von Texten beschreibt.
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Draw Startbildschirm mit Legende

Abbildung 40: Draw Startbildschirm mit Legende
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Draw Seitenleiste Eigenschaften mit Legende

Abbildung 41: Draw Seitenleiste Eigenschaften mit Legende
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Weitere Informationen

Handbücher der LibreOffice Community
Die Handbücher für die einzelnen Anwendungen bestehen aus mehreren Kapiteln. Die 
Kapitelübersichten finden Sie auf der Webseite von LibreOffice - The Document Foundation
LibreOffice Handbücher (auf deutsch) / https://tdf.io/dedocs
LibreOffice Handbücher (englische Versionen) / 
https://wiki.documentfoundation.org/Documentation/Publications
LibreOffice bietet sechs Anwendungen (Komponenten) für die Erstellung und Bearbeitung
von Dokumenten und zur Datenverarbeitung:

• Writer - Textverarbeitung
• Calc - Tabellenkalkulation
• Impress - Präsentationen
• Draw - Zeichnungen
• Base - Datenbanken
• Math - Formeleditor

Die Kapitel
Jeder, der sich schnell mit LibreOffice vertraut machen möchte, wird die Kapitel zu schätzen 
wissen. Vielleicht sind Sie neu in der LibreOffice Suite oder Sie sind mit eine anderen Office-
Suite vertraut. Die Kapitel von LibreOffice bieten Ihnen themengenaue Informationen.

PDF-Versionen
Alle Kapitel können frei als PDF-Version heruntergeladen werden:
LibreOffice Handbücher (auf deutsch) / https://de.libreoffice.org/get-help/documentation/

Die Autoren
Die Handbücher werden von Freiwilligen der LibreOffice-Community erstellt.

Über LibreOffice
LibreOffice ist eine leistungsfähige Office-Suite, für verbreitete Betriebssysteme wie 
Windows, GNU/Linux 32-/64-Bit und Apple Mac OS X geeignet.
LibreOffice entsteht aus der kreativen Zusammenarbeit von Entwicklern und der 
Gemeinschaft der Stiftung The Document Foundation / 
https://de.libreoffice.org/about-us/governance/. Die Stiftung hat ihren Sitz in Berlin / 
Deutschland.
Das Programm LibreOffice kann unter der Adresse LibreOffice Download / 
https://de.libreoffice.org/download/download/ kostenlos heruntergeladen werden.
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Kapitelübersicht - Draw Handbuch
Kapitel 1 - Einführung in Draw
Kapitel 2 - Zeichnen von Formen
Kapitel 3 - Arbeiten mit Objekten und Objektpunkten
Kapitel 4 - Objekteigenschaften ändern
Kapitel 5 - Arbeiten mit mehreren Objekten
Kapitel 6 - Bilder bearbeiten (Rasterbilder)
Kapitel 7 - Arbeiten mit 3D Objekten
Kapitel 8 - Verbinder, Fluss- und Organisationsdiagramme
Kapitel 9 - Text einfügen und formatieren
Kapitel 10 - Drucken, Exportieren, E-Mailen
Kapitel 11 - Fortgeschrittene Zeichentechniken
Anhang B - Optionen
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Hilfe
So verwenden Sie die Hilfe von LibreOffice.

Offline-Hilfe
Die Offline-Hilfe steht Ihnen nur zur Verfügung, wenn Sie sie auch installiert haben.
Platzieren Sie den Cursor an eine Stelle (Menü, Dialog etc.), an der Sie Hilfe benötigen.
Betätigen Sie die Taste F1, (bei Laptops evtl. Fn+F1).

Online-Hilfe
Die Online-Hilfe wird Ihnen angeboten, wenn Sie keine Offline-Hilfe installiert haben.
Sie können die Online-Hilfe aber auch direkt in Ihrem Internetbrowser öffnen:
LibreOffice online Hilfe

Offline- und Online-Hilfe
Beide Hilfesysteme öffnen sich jeweils in Ihrem als Standard festgelegten Internetbrowser.
Im oberen Bereich befindet sich die Suchleiste. Dort können Sie Ihre Suchbegriffe eingeben. 
Schon bei der Eingabe eines Buchstabens bekommen Sie direkt darunter eine Auswahl von 
Themen. Mit jedem weiterem Buchstaben konkretisiert sich die Auswahl.
Klicken Sie dann in die Auswahl auf ein Thema, um die Beschreibung dazu im mittleren 
Bereich des Fenster zu lesen.

Noch Fragen?
Für Fragen zum Thema gehen Sie zu Ask.LibreOffice:
Fragen auf ask.LibreOffice

Mitarbeit bei LibreOffice
Besuchen Sie uns auch auf der Seite Dabei sein!:
LibreOffice Community

Spenden
LibreOffice ist freie Software und wird kostenfrei zur Verfügung gestellt. Ihre Spende, die 
rein freiwillig ist, unterstützt unsere weltweite Gemeinschaft. Wenn Ihnen die Software 
gefällt, freuen wir uns über eine Spende auf Spenden für die Document Foundation.
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